CLASS -6 ENGLISH - NCERT (POORVI) & THE COMPLETE ENGLISH GRAMMAR AND COMPOSITION
SPLIT-UP SYLLABUS (OCTOBER 2025 - FEBRUARY 2026)

clear
communication
* Enable
students to use

(Phrases)

Goals /

l Teachi hapter (Text + . . Teaching Strat A t
S Month eaching | Chapter (Tex Contents Learning Learning Activities cac mg_S rategy sses_srT\en
No Days Grammar) (NEP Aligned) Activity

Outcomes
Unit—3/Want | To understand
a Garden, The the perception
Thought of the of the bird in
Trees that the poem
Saved Us *use of Reading aloud, *Explanatory, joyful
Adjectives: imaginary and Recitation, Role learning. *
L . * . Paragraph
Adjectives of perception play, Group Inquire based writin
. Quality, * New discussion, learning &
Unit-3 . . . *Poem
. Quantity, vocabulary Spice hent, *Integrated learning L
Nurturing . . . recitation
Number * ldentify Story narration, with EVS and Art " .
Nature . . . " . Matching
1 | October 18 Verbs: Ancillary | different spices | Vocabulary games, Comparison chart .
Grammar: . . " . . adversity.
L and main verbs | and their health | Flashcards, Poster Learning by doing % o
Adjectives, . . e . Describing
Verbs benefit. making, ldentifying | (activity-based
Verbs, Modals . * .. ) games
expressing the use adjectives in hunt, | Grammer) * Act out a verb
(Present, Past, appropriate Verb action games, | *Peer drawing and
Future) adjectives to Permission please | collaboration
Modals: can, describe nouns. | activity *Art & visual support
could, may, * ldentify verbs
might, shall, in a sentence.
should, will, * Recognize
would model
Enhance
reading,
comprehension, * Formal Role
vocabulary Play,
* Understand Dramatization,
value of Yoga, Debates
language * Role Play * Stand-up
development * Story Mapping demonstration
Unit — 4 * Develop the * Individual/Group & practice
N ability to Posters (real-life
Change of % .
Heart express Peer Interviews themes)
“The winner thoughts * Quiz/Worksheet | Joyful learning, * Tasks focused
Unit — 4 Sports *Yoga- A way of through writing | * experimental on application
and Wellness life g y & speaking Word/Vocabulary | learning, (map work,
5> | November 99 Grammar: Grammar- * Enable Building competency-based, | worksheet,
Active & Passive Active & P.assive students to * Mind Map add & value model)
Voice, Adverbs, Voice. Subiect- understand and | (Benefits of Yoga) | integration, critical * Posters, Essay
Prepositions Verb ! J apply grammar | * Class Discussion thinking, multilingual | Writing on
Aereement * Promote * Voice Drills support Good Routines
Agverbs ’ values, healthy | (Active-Passive) * Open-ended
Pre osit,ions habits, and * Verb Card Game Questions
P emotional * Adverbs Builder * Peer to Self-
intelligence * Picture Correct Test
through stories | Description * Use home
and themes language for
* Build 21st children before
century skills engaging in
such as critical English writing
thinking &
collaboration
* Develop
reaTd.mg, Art, Role Play,
writing, Drawing, poem
listening, and * Role Play WIne, P
. . “ . . Activities
speaking skills * “Incredible India "
. . Phrase
in English collage Construction
* Foster critical | * * Joyful & *Speech
. writing & Skits/Presentations | Experimental P .
Unit—=5 . % 0 - . conversion
creativity My Kite Learning i
. Humara Bharat , * Writing tables.
Unit — 5 Culture . through stories | Vocabulary Competency-based | ,
o (Incredible o ) Humara
and Tradition . and poems Description Learning .
India!) * * v " . Bharat” (links
Grammar: % 1 Encourage Kite Poem Cross-curricular . .
. . Kites ) ) . . with Social
3 | December 16 | Conjunctions, national pride, | Completion Learning .
. Grammar: N * Science)
Direct & . . cultural Sentence Value-based
. Conjunctions, . * Value-based
Indirect Speech, . awareness, and | Connect Education (empathy
Direct & N . . . (Empathy &
Phrases . empathy Conjunction and responsible .
Indirect Speech, . . . responsible
through literary | Bingo choices) .
Phrases £ i * o choices)
texts Dialogue to Multilingual N
* oo . Students may
Build Report Connection . .
* . first describe
grammar Phrase Sorting . .
. . images in
proficiency for * Picture Prompt
mother tongue,

then in English
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English in real-
life and creative
contexts

* Strengthen
core skills in
language
learning
(listening,
reading,
writing,
speaking)

* Instill values
of resilience,
patriotism, and

* Experiential &
Joyful Learning

* Inclusive
Education

* Patriotic
Development
through language

* Understand
the structure

erseverance ”
E Enable * Cross-curricular
approach
students to *pp. . * My Dream
Unit—5 read and Skills like * Paragraph
*Ila Sachani respond to \e/c;:a::r:ary, * Posters
. Embroidering | different text pathy, * Captive
Unit — 5 Culture . teamwork, .
. dreams will her | types , Writing
and Tradition feet * Imbrove collaboration * Fact or
Grammar: . . 'p * Interviews -

4 | January 20 . *National War writing % . Fiction
Punctuation, Memorial mechanics simulation * Peer Editin
Capital Letters, Grammar: through correct " Vocabulary Word Exercises °

Vocabulary - g Wall N
Punctuation, use of * Write/Draw Word
Capital Letters, | punctuation & . Vocabulary in
Vocabulary capitalization Imaginary Tour Context
* Enrich active Journal * Word Puzzle
vocabular * Thank You Letter
through 4 to a Soldier
conte)g(t—based * Patriotism Word
learning and Match Biograph writin
"ng * Punctuation clography. - WrItng,
real-life usage C . joyful recitation,
" orrection Race .
Promote N project-based
. . Vocabulary .
inclusive oy learning, group
. Building s . .
education, writing, illustrative
. : * Treasure Hunt
joyful learning, board games, poster
and making,
competency- contextualized word
based stories, vocabulary
outcomes recall, visual games
* Develop the
ability to read
and interpret
unfamiliar text | * Read and *
* Reach Respond Comprehension
understanding * Group/Pair * Storv Writin Passages with
Reading Readin to express ideas | Reading " Braizstormif Wh- Questions
Comprehension, Com rghension in structured * Individual " g * Picture-based
Paragraph P " | and coherent Writing . Paragraph
. Paragraph * . Collaborative/Shared .\
5 | Februar 20 Writing, Writing, Poster manner Topic-Based Writin Writing
4 Notice Writing, Making’ * Introduce Writing N Therrg1e-Based * Notice for
Poster Making, & formal writing * Guided Writing : School Event
Informal " Poster Projects *
Informal - for Role Play * . Create a
.. Letters, Revision . " Art Integration
Letters, Revision communication Group Poster « Posteron a
* Encourage Activity Letter Exchange Theme
creativity along | * Letter to a Family * Write a Letter
with written Member to a Friend
expression
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and tone of
informal letters
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Mathematics

Class VI
Split-up Syllabus
No. of Name of the Teachin Assessment
SN Month Teaching Content Goal g .
Chapter Strategy Activity
Days
Develop Number puzzles
1 October 20 Number Play Faf:t.or.s,.r.nultlples, understanding of group work, factor Worksheet, cl:.iss
divisibility rules factors and test, MCQ quiz
o trees
divisibility rules
Activities using
Prime numbers Apply prime prime Worksheet, oral
2 November 18 Prime Time tests of divisibili, factorization in factorization, HCF | questions, short
ty problem solving & LCM with test
examples
. Use fractions in real- . .
Types of fractions, . Fraction strips, Worksheet,
. . life contexts . .
3 December 20 Fractions operations, paper folding, activity sheet,
. e (measurement, .
simplification . daily life problems class test
sharing, money)
Playing with Drawing angles, Develop construction Hands-on use of Practllcal
4 January 20 . . . oy compass, exercise,
Construction bisectors, triangles skills in geometry .
protractor, scale diagram test
: . Paper folding, Worksheet,
Lines of symmetry, | Recognize symmetry . L . -
5 February 10 Symmetry . . : mirror activity, drawing activity,
reflection in nature and figures . . .
drawing exercises quiz
6 March Annual Examination




Science
Class VI
Split-up Syllabu

October | Temperature Ch.7- Concept of SDG 3- Students Inquiry-based | Hands-on Oral
&its hot&cold, collect learning, demo: Q&A,Quiz +
measuremen Temperatur | thermometer, Good temperatur | real-life measuring | Practical
t e &is Celsius&Fahr Hea!th&WeI e data from | connections, | temperature & worksheet on
measuremen  enheit scales, I-oeing home fora | integration of water, air, | reading
t measuring week and | with math and body thermometer
temperature compare (graphs) using S
(urban vs thermomete
rural s
differences
)
October | States of Ch.8- Solid, liquid, SDG 6 - Compare Experiential Group Diagram-bas
water gas states; Clean water use | learning, activity: ed
A journey evaporation, | Water & practicesin | activity-based "Mini assessment:
through condensation | Sanitation | different ,integration Water draw & label
states of , melting, cultures & | with Cycleina | processes in
water freezing, climates geography Jar’ water cycle
cooling experimen
effect, water t, Science
cycle lab
experimen

{s



Science
Class VI
Split-up Syllabus


Novembe | Methods of

r

separation

9

Ch.9-
Methods of

separation in

daily life

Handpicking,
sieving,
threshing,
winnowing,
filtration,
evaporation,
sedimentatio
n,
decantation,
distillation

SDG 12 -
Responsible
Consumptio
n &
Production

Collect
kitchen
samples
and
demonstrat
e
separation
techniques
from local
food
traditions

Problem-solvi
ng, critical
thinking,
integration
with home
science

Poster
Making:
“Reduce,
Reuse,
Recycle”,
Group
experimen
ts:
separatin
g salt
from
sand, rice
from husk,
Science
lab
experimen
ts

Practical test:
Students
performone
method of
separation
and explain



Decembe | Living

r

January

creatures &
characteristi
CS

Nature’s
treasures

10

13

Ch.10-

Living
creatures:
Exploring
their
characteristi
CS

Ch.11-

Nature's
Treasures

Classification

of living
things and
non-living
things, basic
features of
plants &
animals,
similarities &
differences,
life cycle of

some animals

and plants

Natural
resources:

SDG 15 -
Life on
Land

SDG 13 -
Climate

renewable & | Action

non-renewab

le,
importance
of

conservation

Collage
showing
diversity of
living
beings
from
different
regions of
India

Story
telling on
onerare or
endangere
d natural
treasure of
their own
state

Collaborative

learning,

project-based,

integration
with art &
environment
studies

Storytelling,
value-based
education,
integration
with social
science

Field visit to
garden/loca
| park for
observation
& recording
of living
things,
Collage:
“Diversity of
Life”

Story Circle:
“If | Were a
Tree’, Best
Out of

Waste Craft.

Oral viva +
observation
sheet check

Group
presentation
+
rubric-based
evaluation




February | The solar
system and

universe

9

Ch.12-

Beyond the
Earth

Solar system, | SDG 9 -

planets, Industry,

satellites, Innovation

stars,space | &

exploration Infrastructu
re

Compare
space
myths &
stories
from
different
cultures

Use of digital
tools,
storytelling,
interdisciplinar
y with history
& technology

Model
making:
solar system
/
constellatio
n chart

Written test +
peer
assessment
of models




Social Science
Class VI
Split-up Syllabus

SN Month No. of Name of the Content Goal Teaching Strategy Assessment
Teaching Chapter Activity
Days
1 October 20 Ch-3 Key Landforms and Identify and Classify use a multi-faceted Map Work, Drawing

Landforms and
Life.

Ch-13
The Value Of
Work

Their Characteristics,
Influence on Life,
challenges and
opportunities of living

in mountainous regions.

Definition and
Importance of Work,
Economic Activities,
Non-Economic
activities, Dignity of
Labour, Community
service.

Landforms,Understand
Landform Characteristics,
Explain the Influence of
Landforms on Life,
Appreciate Human-
Environment Relationship,
Connect Landforms to
Resources and Culture.

Differentiate between
economic and non-economic
activities, Recognize the
value of diverse work,
Promote respect for all jobs,
Appreciate the
interconnectedness of
society.

approach including
interactive activities
like paper folding for
fold mountains and
nature walks to
observe plains.
Emphasize visual
aids like maps and
Google Earth, paired
with discussions on
real-world examples
of how landforms
affect climate and
human life.

Using storytelling
about community
members' various
jobs (like Anu and
Kabir's example),
differentiate
between economic
(money-earning)
and non-economic
(love-based) work,
discuss how all work
contributes to
society, and
encourage activities
like creating a
community map to
show different jobs
or writing about

and Labelling,
Worksheets, Exercise
based questions and
activities.




family members'
work to reinforce
the concepts of hard
work, dignity of
labor, and teamwork

November 18 Ch-6 Focuses on the Indus Understand Urban Planning | Visual Aids & Videos, | Worksheets, Group
The Beginnings | Valley Civilization (also | and City Life, Agriculture Reading & Note- Discussions and
of Indian known as the Harappan | and Trade, Culture and Taking. Quizzes to check
Civilisation. Civilization), a major Craftsmanship, Societal understanding and

ancient urban culture Organization, encourage

that emerged around Understanding Civilization. students,Practice
2600 BCE along the Questions and
Indus and Sarasvati Solutions.

river.

December 20 Ch-11 Panchayati Raj System, | To teach students how the Use a three-tier Worksheet, activity
Grassroots Gram Sabha, Gram Panchayati Raj system system approach by | sheet, class test,
Democracy PanchayatRole of Local | provides local self- explaining the Gram | MCQ's, Role play
:Part 2 -Local Government. governance in villages, Sabha, Gram activities to
Government in empowering communities Panchayat, and understand local
Rural Areas to participate in decision- Sarpanch through governance.

making, address their case studies and
unique needs, and promote | visuals, followed by
development through a engaging activities
three-tier structure of like mock village
elected bodies at the village, | meetings or creating
block, and district levels project plans to
connect concepts to
real-world
governance and
foster active
citizenship in
students
January 20 Ch-12 Urban Local Bodies, Understand Urban Interactive Create a Comparison
Grassroots Functions and Governance, Identify Activities, Citizen Table, Exercise
Democracy - Responsibilities, Citizen | Responsibilities of Urban Participation Project, | questions,
Part 3: Local Participation, Bodies, Explain Role-Playing. Worksheets.
Governmentin | Importance of Urban Participatory Democracy,
Urban Areas Governance. Highlight Citizen

Roles,Recognize the
Importance of Local
Government.




February

10

Ch-14
Economic
Activities
around Us

Primary Sector,
Secondary Sector,
Tertiary Sector,
Interconnectedness of
Sectors.

Understand Economic

Activities, Classify Economic

Activities, Recognize

Interdependence, Connect
to Everyday Life, Grasp

Societal Impact.

Using hands-on
activities, real-world
examples, and a
focus on the three
economic sectors:
primary (resource
extraction),
secondary
(manufacturing),
and tertiary
(services).

Worksheet, Exercise
activities, quiz, role
play




Sanskrit

Class VI
Split-up Syllabus
ST | UTeg - Rrvaa e Rrerorfisar TWE (NEP et
& fe i gal | aeUsH, IR AUTITT Bfer: TeHTISTH, | SFIHATHD- MRAGULRRY,
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: . . .
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g fami= TH AU | SIRIAYIHHdIG:, | HdgIRasian HdlgusH, SHATEHD- MRAG AT,
TS BRERCACK! IRGHATINT, JHB, ST, g1, dare-
(eI, IR0, | ReGHUUSRA(S: fese AT 3nam: | Tarenam:, SHF:
T HYROA), qEUTSI-gH I
gD HAIG: ST
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ST ST, SIRIGH, femauiHe, HU1- | e, - | ag-fHeRereyq
CRISIERE) B AU =, YfHenT- e (R,
jgf&#ﬁmv TRATGA FRfAqH | SHfa: ggﬁmyﬂamﬁ-
NCEIE] J&T: TS | TAhUSH, g&Ton | faenfiy gemm DTS, SFHATHD- XABUTS -t b4,
Bl JUHIRGH, SR, Hraniere], T, geifavae-Hereray,
HGSHTH JUBHRHTGT JARITUGYTY, | URIISHIR - UYRRY




STEYTH
(Plantation
Activity),

TenTRa-Rieom




Computer Science

Class VI

Split-up Syllabus (Live Wire Book)

Month Chapter Name

Sub Topics Experiment

Project

Activity

ocT

Formulas and Functions in Excel

> Sorting and Filtering

> Conditional Formatting
> Formula in Excel

> Functions in Excel

> Cell Referencing

> Cell Reference of Another
Worksheet

> Formula Errors

Add the numbers using Formula in MS
Excel

NOV

Image Editing with GIMP

> About GIMP

> Starting GIMP

> Interface and its Components
> Opening a File

> Toolbox and Selection Tools

> Paint Tools

> Retouching and Transform Tools
> Flipping and Rotating a Image
> Saving and Closing a File

Open an image with the help of Bucket
Fill Tool and Change the Colour




DEC

Coding in C++, Python, and Java

> Introduction to C++, Python, and
Java

> Similarities between C++, Python,
and Java > Differences between C++,
Python, and Java > Practice Code

Write a Code to enter the marks

JAN

Coding with Python

> Introduction to Python

> Applications of Python
Programming

> Installing Python

> Components of Python Window
> Interactive Mode

> Variables in Python > Script Mode
> Creating a Program File

> Data Types

> Using input() Function

> Operation and types in Python
> QOperator Precedence

Create a Code to Convert Temperature
from Fahrenheit to Celsius

FEB

Cloud Computing

> Introduction to Cloud Computing
> Characteristics of Cloud Computing
> Advantages of Cloud Computing

> Storing and Sharing Data using
Cloud Computing

> Google Drive

> One Drive

> Google Maps

Create a PowerPoint Presentation on
“Cloud Computing”

MAR

Annual Exam - Revision




Art & Craft
Class VI

Split-up Syllabus

Learning

Month Topic Content Activity Assessment
Different types of Muaii(llilrllg Neatness,
October Quilling Art - yP d & creativity,
quilling designs flowers & . :
design variety
borders
Posters on themes Creating Message
November | Poster Making (environment, theme-based clarity,
school events) posters creativity
Collage Paper collage with Making Arrang.erpent,
December L collage creativity,
Painting colors .
pictures color use
Land_s cape Scenic drawing Painting Color use,
January with : neatness,
with watercolors landscapes o
Watercolors composition
Februar Ink Pen Drawing/sketching | Making pen ]z}elga(;iﬁlg,
y Drawing with ink pens sketches 5

originality




Physical Education and Sports
Class VI
» October: Fitness drills, skipping

» November: posture training, march past
» December: Athletics (sprints, jumps)
» January: Football, basketball, volleyball basics

» February: Lead up games



